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Introducing the Ingest system

LiveU's Ingest system enables the ingest of IP streams for television news and remote live
TV production.  

Live video is streamed to LiveU’s MMH server, where it is is divided into chunks every five
seconds. Each chunk is assigned the same ID plus a differentiating suffix from 0 and up. The
video is then transferred from the MMH server to a shared folder on the Ingest server, where
the video is transcoded.

Several additional folders are created on the Ingest server, including:

▪ Output: Separates the transcoded output into folders for low resolution and high
resolution video files.

▪ Recording: Copies of the video chunks and IDs that were transferred from the MMH
server.

Video recordings can be viewed and managed from the Ingest portal on the LiveU Central
management platform.

The following diagram illustrates the flow of information from the LU transmitting unit, to
the MMH server to the Ingest server.
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Introducing the Ingest portal

Recorded media is transferred from the MMH server to the shared folder on the Ingest
server, where it is transcoded.

Low resolution video recordings and their associated metadata are displayed in the Ingest
portal. From the portal, you can view and download the video, adjust playback speed and
view the location of the transmitting unit.

You can access the Ingest portal from the LiveU Central management platform.

Opening the Ingest portal

To access the Ingest portal:

1. Go to https://ingest.liveu.tv.

The LiveU Ingest Log In page appears.

2. Fill in your username and password and click Log In.

Alternatively, you can log in to the LiveU Central management
platform, click  at the top left corner of the window and select
Ingest Portal from the menu.

The Ingest portal window opens, displaying Ingest video thumbnails.

Introducing the Ingest portal
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The thumbnails also display the video ID, the date and time of the recording and the
timecode. At the bottom of the thumbnail, the video title is displayed. The video title
is the same as the metadata slugline.

Scrolling through a video's thumbnail
The Ingest server's Output folder includes a thumbnails folder. Thumbnails are created
every minute from multiple .mjpeg preview images, per recording.

You can scroll through the images by placing the cursor on the thumbnail and dragging the
blue line to the left or to the right.

Introducing the Ingest portal
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Playing the video
The Ingest portal is populated with the thumbnails of all the video files on the Ingest
server.

Clicking a thumbnail opens the video in low resolution on the right side of the portal
window.

The selected thumbnail is outlined in blue.

From the video preview pane, you can do the following:

▪ View / pause video playback

▪ Download the video

▪ Adjust playback speed

▪ View video in a floating window

An option to trim the video will become available shortly.

The Details tab displays the video's metadata and provides information on the video,
such as file size and video resolution.

The video plays back until the end of the recording. If the recording session is still in
progress, the playback updates on the fly. If there is a delay between the ongoing recording
session and its upload to the Ingest server, a revolving indicator appears on the video
screen.

Introducing the Ingest portal
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Viewing GPS coordinates
In the right pane, clicking the Location tab displays the GPS coordinates of the transmitting
unit.

Viewing Ingest information
In the right pane, clicking the Ingest Info tab displays the name of the transmitting unit, the
destination channel and the Ingest server name.

Introducing the Ingest portal
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Downloading the video
You can download the video from the following locations:

▪ Video preview pane: Click the Download icon.

▪ Video file: Click the Download button.
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Playback speed and Playing in picture
From the Ingest portal, you can do the following:

▪ Adjust playback speed

▪ Play Picture in picture

You can access these options by clicking the menu in the following locations:

▪ Video preview:

▪ Video file:

You can then select one of the following options from the popup menu.
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Filtering the view
You can filter the type and dates of the videos that are displayed in the Ingest portal.

To filter the view:

1. Move the mouse over the left side of the portal window.

The Filters panel slides out.

You can click the pin to prevent the panel from sliding back.

2. From the Date dropdown list, select All, Today or Yesterday.
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Appendix A: Ingest LiveU / iNEWS
Integration

Introducing LiveU / iNEWS integration
LiveU is integrating with iNEWS AVID to enable the sharing of story queues configured in
iNEWS.

iNEWS AVID allows the user to add / delete and schedule specific stories to and from the
queue.

The queues are shared with LiveU and their associated stories (metadata) are displayed in
LiveU Central.

AVID technology is now known as Media Central for Newsroom
Management. However, iNEWS continues to be used in its integration
process with LiveU and is referred to by that name in this guide.

Delegating tasks
On purchase of the integration license, the LU Central user receives an iNEWS user name
and password. This license enables access to the FTPS server, which interfaces between LU
Central and iNEWS.

The following table describes the respective tasks that are performed first in LU Central and
then in iNEWS.

Central user iNEWS user
Upload the XSLT file in the Story
Synchronization Settings window.

 

Enter required information into the
System Configuration fields

 

Add a user

Create a queue

Associate the queue to a TXNET job

Associate the job with the queue's
mailbox

Create a story

Setting up story integration in LU Central
On activation of the iNEWS integration license, a user name is automatically generated in
LiveU.

The procedure has two sections: Uploading the XSLT file and Configuring story integration
settings.
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Uploading the XSLT FILE

The SXLT file parses the story parameters provided by iNEWS and maps them to the
parameters used by LiveU.

To upload the XSLT file:

1. In LiveU Central, click the Stories tab.

2. At the top of the screen, click Settings.

3. In the Metadata Mapping area, click Upload File.

Uploading the XSLT file allows iNEWS to create templates at a later date that are
compatible with the parameters supported by LiveU.

4. Browse to the XSLT file you want to use to map with the XML file provided by iNEWS
and click Open.

The XSLT file name is displayed in the field.

Appendix A: Ingest LiveU / iNEWS Integration

Ingest Portal User guide 10



NRCS Story Synchronization switches to ON.

Here is an example of the LiveU XSLT file.
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If you encounter a problem uploading the file, or if you need help in creating a
compatible template, contact LiveU support.

Configuring story integration settings

The following procedure is performed after the XSLT file has been uploaded to LiveU. After
the XSLT file is uploaded, NRCS Story Synchronization automatically switches to ON.

To configure story integration settings:

1. In LiveU Central, click the Stories tab.

2. At the top of the screen, click Settings.

The following screen appears.

Appendix A: Ingest LiveU / iNEWS Integration
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The NRCS System field is filled in by default.

In the System Configuration area, the frequency with which the FTPS server scans
iNEWS for new stories is specified in the Sync Interval field. This is the default interval
and it cannot be changed.

In the Story FTPS Export Credentials area, the address of the FTPS server is displayed
in the URL field by default.

3. Click Show next to the Password field.

4. Type your LU Central password into the field and click OK.

You are returned to the Story Integration Settings screen.

The system generates a user name and password to use in the iNEWS integration
process.

Appendix A: Ingest LiveU / iNEWS Integration
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5. Click OK.

It is recommended that you copy / paste the URL, user ID and
password and keep them in an accessible location. All these items
are required for completing the integration process in iNEWS.
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Adding a user in iNEWS

To add a user in iNEWS:

1. In the iNEWS main screen, in the Directory tab in the left pane, go to Tools > Options >
Users.

The Manage User Accounts screen appears.
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2. Click New User.
The Add New User screen appears.

3. Type or paste your user ID into the User ID field.

Your user ID was auto-generated in the LU Central Story Integration Settings window.

4. In the Password area, click Password

5. Type or paste your password into the password fields.

Your password was auto-generated in the LU Central Story Integration Settings
window.

6. Click Add and then click Close.

You are returned to the iNEWS main screen.

If you are working with iNEWS version 2021.3 and up, you need to perform the following to
add the TXNET user to the vault.

To add the TXNET user to the vault:

1. Log in to your iNEWS Linux server via SSH.

2. Execute the following command:
vaultcl add LiveUFTP user

Password:

Re-enter password:

The following message appears: Credentials for user LiveUFTPuser successfully
added.

Your user ID and password were auto-generated in the LU Central Story Integration
window.
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Modifying a user account

To modify a user account:

1. In the iNEWS main screen, go to Tools > Options > Users.

2. Type the first few characters of the user's ID followed by an asterisk (*) in the User ID
field then click Search.

User IDs matching your search string appear in the pane

3. Double-click the user ID whose account you want to modify.

The Modify User Account screen appears.

4. Modify the user's details as required.

5. Click OK and then click Close.

Working with queues
Stories are assigned to queues. The iNEWS user can use an existing queue for new stories or
create a new queue.

To create a queue:

1. In the iNEWS main window, in the Directory tab in the left pane, right-click Assign.

2. From the sub-menu, select New Queue.

A new queue appears in the LiveU tree. The default name New-Queue is highlighted.

3. Type a descriptive name for the queue to replace the default name.
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To delete a queue:

1. In the iNEWS main window, in the Directory tab, in the left pane, right-click the queue
you want to delete.

2. From the sub-menu, select Delete Queue.
The Confirm Delete window appears.

3. Click Yes.
Selecting Answer 'Yes' to all deletes all the queues in the directory.
The selected queue is deleted.

Associating a queue to a TXNET job
Each queue you want to share with LiveU must be associated with a TXNET job.

TXNET is the protocol over which the story assignments in the selected queue are shared
with the user account in the FTPS server. The job synchronizes the queue with the FTPS
server.

Configuring the TXNET job is performed once per queue.

To associate a queue to a TXNET job:

1. In the iNEWS main window, in the Directory tab in the left pane, expand Assign to
display the LiveU queue directory.

2. Select a queue.

3. Expand System > Configure.

4. Scroll down the Job List and double-click an available job that is associated with
TXNET.
The selected job number is displayed under Slug in the right pane. The job number is
also used for the mailbox number.

5. Copy or make a note of the Job List number.

6. In the right pane, type the following:
scan <queue name>

open <URL> <username> 4nsml

Use the URL and user name you copied from the LU Central Story
Integration Settings window.

put /

put / indicates that the stories in the queue are to be transferred
to the FTPS server.

The following is an example.
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The system scans the selected LiveU queue and forwards the queue's assignments to
the shared directory on the FTPS server.

LiveU Central then displays the story in the list in the Stories tab.

Associating the job with the queue's mailbox

To associate the job with the queue's mailbox:

1. In the iNEWS main window, in the Directory tab in the left pane, expand Assign to
display the LiveU queue directory.

2. Right-click the required LiveU queue and from the sub-menu, select Properties.

The Queue Properties screen appears.

3. Click the Maintain tab.

4. In the Mailbox area, in the Standard field, click the arrows to display the mailbox
number.
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5. Click OK.

Creating a story in iNEWS
You need to add stories manually.

To create a story in iNEWS:

1. Log in to iNEWS.

2. In the left pane, in the Directory tab, expand the Assign folder to display the LiveU
queue directory.

3. Select the required LiveU queue, then select File > New Story.

In the right pane, a new row is added at the top of the story grid.

The Time column shows the time the story was created.

4. Type the name of the story in the Slug column

5. Type the relevant information in the remaining columns.

6. Fill in the story's metadata.
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7. In the right pane, type a comment, if required.

8. Open the Stories tab in LU Central and refresh the view.

The story is pushed to the FTPS server and is displayed in the Stories list.
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Appendix B: Ingest LiveU / Telestream
Integration

Introducing Ingest / Telestream integration
LiveU's Ingest system enables media to be recorded on all channels and archived in a
shared folder on the Ingest server.

The media can be monitored and managed via the Ingest portal.

In addition, LiveU's Ingest solution enables the automatic and manual forwarding of all or
specific media files and associated metadata to an external MAM / PAM system.

This option is available by integrating a 3rd party software, the Telestream Vantage media
processing platform.

Prerequisites

Telestream Vantage license: V-XCODECONN-SW

Vantage Transcode Connect: Software Only, Single Server License. Includes Vantage Workflow
Designer, SD & HD New Media, Edit, H.264 and MPEG-2 Transcoding Format support. Also
includes broadcast server monitoring, XML metadata transformation and delivery, web service
notification.

LiveU / Telestream Vantage integration overview
LiveU recording sessions are transferred together with their associated metadata from a
shared folder on LiveU's Ingest server to external MAM/PAM archiving systems, using the
Telestream Vantage media processing platform.

Telestream Vantage identifies the presence of a media file in the Ingest shared folder,
extracts the associated metadata, processes and formats the video, and checks-in the file to
AVID archives, using AVID protocols.

This guide describes how Telestream Vantage is used to push recorded media from a shared
folder on the Ingest server to the AVID MAM/PAM archiving system.

Setting up Telestream Vantage
This procedure is performed from the Telestream Vantage Management console.

Before you begin this procedure, make sure that you can access
the Ingest server from the machine on which Telestream Vantage is
installed.
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To set up Telestream Vantage:

1. Open the Telestream Vantage Management console.

The following window appears. The Settings & Options > General tab is active.

2. Click the Authorization tab.

3. At the bottom of the window, add the following credentials:

▪ Username: <company domain / user name>/liveu

▪ Password: liveuingest

▪ Folder: <ip_ingest_server\ingestshare>

4. Click Test .
A message appears confirming that the specified credentials are valid.

5. Click Save .
The company's domain / user name appears at the top of the pane. The following
figure shows an example, using LiveU credentials.
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Configuring AVID Interplay communication
This procedure is performed from the Telestream Vantage Management console.

Communication with AVID Interplay is through an interplay web services interface (IPWS).

The IPWS can be installed on one of the devices on the AVID network or installed locally on
the Telestream setup.

If you are already using Telestream Vantage and AVID, the IPWS exists
in your setup.

To configure AVID Interplay communication:

1. In Telestream Vantage Management, click the Interplay tab.

The following window is displayed.
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2. At the bottom of the window, fill in the following fields:

▪ Name: LiveUAvid

▪ Interplay Web Services Host: IP of the IPWS host

▪ Interplay Web Service Port: Port number of the IPWS host

▪ Interplay Workgroup: LiveUWorkgroup

▪ Interplay Username: AVID

▪ Interplay Password: <Company Admin assigned password>

3. Click Test and then click Save.

Importing workflows
The following procedure is performed from the Telestream Vantage Workflow Designer.

LiveU has provided your organization with an example workflow. This workflow offers an
example of how to complete the workflow configuration process. However, some settings
can be changed according to your organization's requirements.

The example workflow must be copied to the machine where Telestream Vantage is
installed before it can be imported into the Workflow Designer.

To import workflows:

1. In the Vantage Workflow Designer, from the File menu, select Import Workflows.

2. Navigate to the LiveUIngest directory, select the LiveU example workflow and click
Open.
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The following window appears.

3. Type or select from the dropdown menu the workflow category and click OK.

Selecting Use folder name allows you to use the name of the folder, containing the
imported workflows, as the category name.

A counter displays the import status of the files.

The workflow actions are displayed in the right pane.

Each node in the workflow is referred to as an action.

Example workflow

LiveU has provided your organization with an example workflow to help you configure the
workflow for your organization.
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The workflow shows Telestream Vantage performing the following tasks:

▪ Waits until high quality media and metadata appear in the shared folder on the Ingest
server

▪ Transcodes the files to DnxHD 1920x1080i 59.94

▪ Extracts the relevant metadata information from LiveU's metadata files

▪ Generates a headframe (.jpeg thumbnail)

▪ Ingests the media, metadata and headframe to the AVID MAM system

About the example workflow
LiveU has provided your organization with an example workflow to help you configure the
workflow for your organization.
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The workflow shows Telestream Vantage performing the following tasks:

▪ Waits until high quality media and metadata appear in the shared folder on the Ingest
server

▪ Transcodes the files to DnxHD 1920x1080i 59.94

▪ Extracts the relevant metadata information from LiveU's metadata files

▪ Generates a headframe (.jpeg thumbnail)

▪ Ingests the media, metadata and headframe to the AVID MAM system

Configuring the Watch action
The following procedure is performed from the Telestream Vantage Workflow Designer in
the Workflow Design tab.

The Watch action represents the directory that is shared with AVID on the Ingest server.

When selected, Watch is outlined in blue.
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To configure the Watch action:

1. Double-click Watch, the first node in the workflow.

The following window appears.

2. In the Watch: Find file and start job window, if necessary, select Any Media and click
Next.

3. If necessary, select Windows File System and click Next.

4. Update the path to \\<Ingest server IP>\ingestshare and click Next then
click Next again.

LiveU recommends not making changes to the Configure settings for this file system
detector window.

5. Optionally select Log Activity to create a text file of submitted and not submitted jobs
and optionally set the destination of the file.

6. Click Next and then click Finish.

Configuring the Associate action
The following procedure is performed from the Telestream Vantage Workflow Designer in
the Workflow Design tab.

Configuring the Associate action involves entering the path of the Watch action to discover
the arrival of new files.

When selected, Associate is outlined in blue.
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To configure the Associate action:

1. Double-click Associate.

2. Click Next, then click Next again.

The following window appears.
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3. Update the path to \\<Ingest server IP>\ingestshare and click Next, then
Next again.

4. Click Finish.

Configuring the Flip64 action
The following procedure is performed from the Telestream Vantage Workflow Designer in
the Workflow Design tab.

Configuring the Flip64 action involves setting up the video container and the transcoding,
resolution, FPS and audio track codecs.

LiveU has pre-configured Flip64 parameters. However, any of these can
be changed according to your organization's requirements.

When selected, Flip64 is outlined in blue.

The following procedure refers to the first Flip64 action in the workflow. There is an
additional Flip64 action one step before the end of the workflow.

To configure the Flip64 action:

1. Double-click Flip64.

The following window appears.
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2. In the Outputs area, select a container format from the dropdown list.

LiveU selected the MXF OP1a container format.

3. Select Video to display Settings, in the right pane.

4. In the Settings pane, scroll down to Codec and optionally change the following LiveU
settings.

Appendix B: Ingest LiveU / Telestream Integration

Ingest Portal User guide 32



▪ Codec: DNxHD

▪ Resolution / Frame Rate: 1080i/59.94

▪ Bit Rate 145Mb/s

5. Select Audio to display Settings in the right pane.

6. In the Settings pane, scroll down to Codec and optionally change the following LiveU
settings.

▪ Number Of Channels: 2

▪ Sample Rate 48000 Hz

▪ Format: 24 Bit Little Endian

▪ Number of channels per track: 1

7. Click Save.

Configuring the Extract action
The following procedure is performed from the Telestream Vantage Workflow Designer in
the Workflow Design tab.

The Extract action in the workflow identifies and extracts specific values from LiveU's
metadata files.
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When selected, Extract is outlined in blue.

To configure the Extract action:

1. Double-click Extract.

The following window appears.

2. Make sure that the source from which the metadata values are extracted is Xml
Extractor and click Next.

The following window appears.

LiveU has already configured the extraction to extract the relevant
data from LiveU metadata files and recommends not changing any
of the values.
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3. Click Finish.

The action displays the metadata files extracted from the media.

Configuring the Notify action
The following procedure is performed from the Telestream Vantage Workflow Designer in
the Workflow Design tab.

Configuring the Notify action transfers job information to external systems via an XML file .

When selected, Notify is outlined in blue.

Do not changes any of the settings already defined in the Notify action.
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Configuring the Media Creation action
The following procedure is performed from the Telestream Vantage Workflow Designer in
the Workflow Design tab.

The Media Creation action delivers new media to the Interplay server specified in
Configuring AVID Interplay communication [24]. You can also set a file's nickname.

When selected, Media Creation is outlined in blue.

How to configure the Media Creation action:

1. Double-click Media Creation.

The following window appears.

2. In the Input area, confirm that the source format is MXF OP1a.

MXF OP1a is a format supported by AVID. LiveU has not yet test other formats.

3. In the right pane, select LiveUAvid from the Interplay Configuration dropdown menu.

4. In the right pane, expand Media Creation Settings, if necessary.

5. If necessary, configure Interplay Folder.

6. Do not change the following settings:
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▪ Interplay Asset Metadata: Metadata values have already been configured by LiveU.

▪ Add User Properties: Confirms user properties have already been configured by
LiveU.

7. Optionally select a new file nickname from the Output media file nickname dropdown
list.

8. Physical File Settings: Click Browse to change the paths from the AVID storage to the
AAF file location and the MXF file location, respectively.

9. Click Save.

Configuring the second Flip64 action
The following procedure is performed from the Telestream Vantage Workflow Designer in
the Workflow Design tab.

Configuring the second Flip64 action in the workflow involves setting the AVID headframe
codec.

When selected, Flip64 is outlined in blue.

To configure the second Flip64 action:

1. Double-click Flip64.

The following window appears.
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2. In the left pane, scroll down to the Keyframe area and select Video 1.

3. In the right pane, scroll down to the Codec area and select a graphic format from the
dropdown list.

4. Click Save.

Configuring the second Notify action
The following procedure is performed from the Telestream Vantage Workflow Designer in
the Workflow Design tab.

Configuring the second Notify action in the workflow involves setting the notification type,
testing the connection and configuring the Interplay notification for headframe check-in.

When selected, the second Notify action - the last action in the workflow - is outlined in
blue.

To configure the second Notify action:

1. Double-click Notify.
The following window appears.
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2. Confirm that Interplay Notifier is selected, then click Next.
The following window appears.
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3. Click Test connection.

4. When the Interplay connection test is confirmed, click OK, then click Next.

5. Click Finish.

Testing the workflow end-to-end

To test the workflow end to end:

▪ Start a live session on an LiveU MMH channel that was configured for the Ingest server.

At the end of the session, the media file appears in the shared folder on the Ingest
server.

Telestream Vantage automatically begins to transfer the media file to the AVID
MAM/PAM archives, according to the workflow setup.

The following figure shows an example of the screen that is displayed in the AVID
Interplay system at the end of the transfer process.
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